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What is Kidproof ?

Kidproof is an application for kids and parents. It allows you, the parent, to protect your 
programs when your child is using the PC. Having Kidproof is like having a child’s desktop 
within your desktop. When you launch Kidproof, you are starting a mini-desktop. You add 
programs to Kidproof that you want your kids to launch. When your child is launching 
programs within Kidproof, the real desktop, your own, is safe and secure. Your kids will not 
be able to access anything that is outside of Kidproof.

Kidproof is very similar to Program Manager. If you know how to use the Program Manager 
then you already know a lot about Kidproof. As for your kids, they just have to point and click
to launch their programs.

With Kidproof, you are not required to exit any application just because your child wants to 
use the PC. Kidproof will protect your already running applications. Your child will only be 
able to access those applications that are started from Kidproof.

CAUTION
PLEASE MAKE SURE THAT YOU DO NOT GIVE YOUR KIDS ACCESS TO PROGRAMS THAT THEY 
CAN USE TO ACCESS OTHER (YOUR) PROGRAMS AND FILES. EXAMPLE OF THESE PROGRAMS 
ARE FILE MANAGER, NOTEPAD, ETC. IF THE KIDS ARE GIVEN ACCESS TO SUCH PROGRAMS 
THEN THEY WILL BE ABLE TO ACCESS YOUR PROGRAMS AND FILES VIA THESE PROGRAMS. 
KIDPROOF IS PRIMARILY INTENTED FOR KID'S PROGRAMS SUCH AS GAMES AND 
EDUCATIONAL SOFTWARE.



What is a program item?

A program item is an application which is shown as an icon in the application window. By 
double-clicking on the icon, the application can be launched. The icons on the Program 
Manager desktop are also called program items. Every program item in Program Manager 
has some information called the Properties of the program item.    

The concept of a program item in Kidproof is very similar. The fields of the Kidproof Program 
Item Properties are explained below: 

Description: 
This field is the description of the program item (e.g, PBrush) which appears below the icon 
displayed in Kidproof.

Command:
This field is the name of the executable file (e.g., C:\WINDOWS\PBRUSH.EXE) which will be 
run when the icon displayed in Kidproof is clicked.

Working Directory:
This field is the name of the subdirectory (e.g. C:\WINDOWS) from where the executable will 
read the related file.

Kidproof Program Properties, Show Program Manager Icons Change Program Properties



What is a KID File?

All program items that you add to Kidproof have to be saved to a file with the extension .KID.
You will be able to create as many .KID files as you like, each with a different set of programs
and preferences. If you have two or more kids of different ages, you may want to create 
more than one .KID file, one for each kid, each containing similar or different program items 
and preferences.

Remember that the preferences are saved in the .KID file and therefore are applicable only 
when the .KID file containing them is opened in Kidproof. 

When you install Kidproof, a default .KID file called KIDPRO.KID is created. If you have only 
one kid using your PC or all your kids are launching the same applications then this default 
file will be sufficient for you to save all the program items and preferences that you have 
selected.

Opening a New .KID File
Opening an existing KID File
Saving an opened .KID file with the same file name
Saving an opened .KID file with a different file name



What is protected mode?

The Kidproof application runs in two modes. One called the protected mode and the other 
being the unprotected mode.

When your kids want to use the PC, you will run Kidproof in protected mode. Running 
Kidproof in protected mode prevents your kids from accessing or deleting your programs. 
Your children will only be able to run programs that you have given them access to.

When you are setting up the Kidproof application, you have to be in unprotected mode. This 
mode allows you to add, change or delete program items, set your preferences for your child
and save the program items and preferences to a file.

Startup Preferences, Protected Mode Preferences



Copy program items from the Program Manager

If you want to copy program items from the Program Manager, into the Kidproof’s KID file, 
select the Show Program Manager Icons option from the Program menu.



Delete Program items from Kidproof

A program item can be deleted by pressing the Del key or by selecting Delete option from 
the Program menu.



Change properties of a program item

Once you have added program items to Kidproof, you may want to change the properties of 
the program item. To change the description (name shown below the icons), command 
(executable file name and any command line arguments), working directory and/or the icon, 
select the program item you want to change by clicking on the icon and then select the 
Change Properties option from the Program menu.



Set up the password

When you want to exit Kidproof or would like to switch from protected mode to unprotected 
mode, you will be required to enter a password. This prevents that your kids from being able
to ‘Unprotect’ your PC by switching back to Unprotected Mode or by exiting Kidproof. To set 
the password which will be required to switch Kidproof to Unprotected Mode, select Password
from the Preferences menu.



Disable the screen saver in the protected mode

Most of the time when your children are using the PC, you may not want the screen saver to 
start because you screen saver may be password protected. If you child is distracted for a 
while and the screen saver starts then your child may not be able to get back to his or her 
programs because of the password protection. If a situation like this happens on your PC 
then you can disable the Screen Saver when Kidproof is in Protected Mode. To set this 
preference select Protected Mode from the Preferences menu:



Disable help from the launched applications

Sometimes getting help screen is not helpful if it means that your kids cannot get back to 
what they were doing. Your kids could press the help button and would not know the way to 
get back to their programs. To prevent this problem you can disable the Help screen by 
selecting Protected Mode from the Preferences menu.



Show Program Manager Icons dialog box

Use this screen to add program items that are already defined in the Program Manager 
desktop.

Add to Kidproof
Select the program items that you would like to add to the Kidproof’s .KID file by clicking 
on the icons shown on the screen. You can select one or more program items. Once you 
have selected the program items, click the Add to Kidproof button to add the program 
items to the Kidproof’s .KID file.



Delete Item (Program menu)

Use this command to delete the selected program items from the .KID file. 



Add or Change Program Item Properties 

Kidproof Program Properties dialog box

Use this screen to add or change the properties of a program item in Kidproof.

Description
Enter the description of the program item as you would like to see below the program’s 
icon on the Kidproof main screen.

Command Line
Enter the location of the executable file and any necessary command line parameters. If 
you don't know the name and/or location of the executable file, you may click the Browse
button to search and select the executable file.

Working Directory
Enter the path where the files required by the executable file are located.

Change Icon
Click this button if you want to select another icon that will be shown on the Kidproof 
main window for the program item.

Browse
Click this button to search and select the executable file for the program item.



Program Menu

The Program menu offers the following commands

Add Item Adds a program item to the .KID file in 
Kidproof

Change Item Properties Changes the properties of a program item 
in Kidproof

Delete Item Deletes a program item from the 
opened .KID file in Kidproof

Show Program Manager 
Icons

Displays program items from Program 
Manager which can be added to Kidproof.



File menu commands

The File menu offers the following commands:

New Creates a new .KID file.
Open Opens an existing .KID file.
Save Saves an opened .KID file using the same file name.
Save As Saves an opened .KID file to a specified file name.
Exit Exits Kidproof.



Technical Help

If you are having problems using Kidproof, or if you have questions or feedback about 
Kidproof, please write, call, fax, or email us at

Address: 
Applied Softworks, Inc.
P. O. Box 2508
Santa Clara CA 95055-2508

Voice: 408-554-1010
Fax: 408-554-1010

CompuServe ID: 74131,2630
Internet ID: 74131.2630@compuserve.com



Preferences Menu

The Preferences menu offers the following commands

Startup Displays and accepts your Startup preferences
Protected 
Mode

Displays and accepts your Protected Mode preferences

Confirmatio
n

Displays and accepts your Confirmation preferences

Password Allows you to add, change or blank out your password



Startup (Preferences Menu)

Use this screen to specify the following Startup preferences:

Protected mode
Check this field if you want Kidproof to start in Protected Mode when the .KID file 
containing this preference is opened.

Unprotected mode
Check this field if you want Kidproof to start in Unprotected Mode when the .KID file 
containing this preference is opened

Note: 
The Protected mode preference will not apply when you start Kidproof. It applies when 
the .KID file containing that preference is opened. Refer to the manual for more information 
on how to start Kidproof in Protected Mode when it is launched from the Program Manager.



Protected Mode dialog box

Use this screen to specify the following Protected Mode preferences:

Disable Screen Saver application
Check this field if you want Kidproof to disable your screen saver when Kidproof is in 
Protected Mode.

Disable Help screen
Check this field if you want Kidproof to disable the help screen from the launched 
applications when Kidproof is in Protected Mode.

Maximize Kidproof screen
Check this field if you want Kidproof window to be ‘maximized’ when it is in Protected 
Mode.

Allow ‘Exit Windows’ from Kidproof
Check this field if you want an ‘Exit Windows’ option in the File menu. Clicking on the Exit
Windows option will initiate exit Windows from Kidproof. CAUTION: THIS EXIT IS 
PASSWORD-LESS EXIT.



Confirmation dialog box

Use this screen to specify the following confirmation preferences:

Program Delete
Check this field if you want Kidproof to confirm any deletion of a program item within 
Kidproof.

Go To Protected mode
Check this field if you want Kidproof to confirm before switching to Protected Mode.



Password dialog box

Use this screen to add, change, or blank out a password. You have to enter the following:

Old Password
Enter your old password, if there was a previous password for the .KID file. You will be 
required to enter it to be able to change it.

New Password
Enter your new password.

Retype New Password
Retype the new password that you entered in the New Password field.



Go-To Menu

The Go-To menu offers the following commands:

Protected Mode Switches Kidproof to Protected Mode
Unprotected 
Mode

Switches Kidproof to Unprotected Mode.

Protected Mode



Help menu commands

The Help menu offers the following commands:

Contents Displays the contents page of Kidproof Help
Technical Help Displays how to get technical help on Kidproof
About Displays the copyright notice and version number of your 

copy of Kidproof.
Registration 
Form

Shows how to register.



New command (File menu)

Use this command to create a new .KID file in Kidproof. If another .KID file is already open 
and has been modified before the New command is selected, you will be prompted to save 
that file.

You can open an existing .KID file with the Open command.



Open command (File menu)

Use this command to open an existing .KID file. If another .KID file is already open and has 
been modified before the Open command is selected, you will be prompted to save that file.

You can create new .KID file with the New command.



File Open dialog box

The following options allow you to specify which .KID file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 

List Files of Type
Select the type of file you want to open. Kidproof only supports files with the extension 
KID

Drives
Select the drive in which Kidproof has stored the file that you want to open. 

Directories
Select the directory in which Kidproof has stored the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Save command (File menu)

Use this command to save the .KID file to its current name and directory.    When you save 
a .KID file for the first time, Kidproof displays the Save As dialog box so that you can name 
your file.    If you want to change the name and directory of an existing .KID file before you 
save it, choose the Save As command.



Save As command (File menu)

Use this command to name and save the .KID file.    Kidproof displays the Save As dialog box 
so that you can name your .KID file.    

To save a .KID file with its existing name and directory, use the Save command.



File Save As dialog box

The following fields allow you to specify the name and location of the .KID file you're about 
to save:
File Name

Type a new filename to save the program items and your preferences with a new file 
name.    A filename can contain up to eight characters and an extension of up to three 
characters.    Kidproof adds the extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to save the file.

Directories
Select the directory in which you want to save the file.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Exit command (File menu)

Use this command to end your Kidproof session.    You can also use the Close command on 
the application Control menu.    Kidproof prompts you to save the unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



New command (Window menu)

Use this command to open a new .KID file. If another .KID file is already open and has been 
modified before the New command is selected, you will be prompted to save that file.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of 
Kidproof.



Title Bar

The title bar is located along the top of the Kidproof window.    It contains the name of the 
application and the name of the .KID file you may be have opened. If you have not opened 
any .KID file, the title bar will not show any .KID file name.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.



Scroll bars

Displayed on the right size of the Kidproof window.    The scroll boxes inside the scroll bars 
indicate your vertical location in the Kidproof window.    You can use the mouse to scroll to 
the other parts of the window.



Size command (System menu)

Use this command to display a four-headed arrow so that you can size the active window 
with the arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so that you can move the active window 
or dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.



Minimize command (application Control menu)

Use this command to reduce the Kidproof window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.



Maximize command (System menu)

Use this command to enlarge the active window to fill all of the monitor screen.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Shortcuts
Keys: ALT+F4 closes the Kidproof application or dialog box



Restore command (Control menu)

Use this command to return the active window to the size and position it was before you 
selected the Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so that they overlap and you can see each title bar.    This 
option does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Registration Form dialog box

Using this screen, you can register your copy of Kidproof.

CA Resident box
If you are a California resident, check this box. 

Name, Address, Country
Enter your name and address on the screen. The registered copy of Kidproof and the 
manual will be mailed to your address.

When you press the Print button, the Registration form will be printed with the name and 
address you entered. Enter you choice for program disk size and your method of payment 
and mail the form to Applied Softworks Inc. The address could be found in the Support 
section of the manual.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.








